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Fixed It! ScoreBook Help Utility
Thank you for your interest in Fixed It! ScoreBook for Baseball.    We hope the 
information provided in our help utility will answer most of your questions 
about our product.

and when you hit the big leagues . . .



Teams & Rosters
Before you can use ScoreBook to score a game, you must first create at least
two team files.

To create a team file:
    - Select Team from the File Menu
    - Select New
    - Enter a Team Name, Coach, and Manager in the fields provided
    - Select the Edit Roster Button (See figure below)
    - To add a player, enter player information in the Name, Position, Batting 
Order, and Uniform Number fields, then select the Add Player Button.    
Repeat this for each player on the team, then select the OK Button to return 
to the Edit Team Dialog.    As you enter players into the Batting Order, the 
Check Boxes on the field in the lower left will indicate what fielding positions 
are covered in the Starting Lineup.    NOTE: Do not enter a Batting Order 
number for a pitcher if your team uses a designated hitter.    When the game 
Start Button is selected, you will be prompted to select a starting pitcher.
    - Select the OK Button again, then enter a file name for your team.

To import a team file from an ASCII text file:
      - The text file must have the following format:
                  line 1:Team Name (max of 25 characters)
                  line 2:Coach Name (max of 25 characters)
                  line 3:Manager Name (max of 25 characters)
                  line 4..n:Player Name (max of 25 characters), Position(0..14), BattingOrder(0..20), 
UniformNumber(-1..99) 
    - Select Team from the File Menu
    - Select Import
    - Select a Text file from the list provided
    - Enter a file name for your team
    
To edit a team file:
    - Select Team from the File Menu
    - Select Edit
    - Select a team from the list of *.TEM files provided
    - Change any Team fields (Team Name, Coach, or Manager) if desired.
    - Select the Edit Roster Button if you wish to add, delete or change any 
player in the roster.
    - To Add a player, enter player information in the Name, Position, Batting 
Order, and Uniform Number fields, then select the Add Player Button.
    - To Remove a player from the roster, click on the player's name in the 
Current Roster List Box, then select the Delete Button.
    - To Edit a player in the roster, click on the player's name in the Current 
Roster List Box, then change the Name, Position, Batting Order, and Uniform 
Number fields as desired.    For these changes to take affect, either select the
OK Button or click on any player name in the Current Roster List Box.



    See also:
      Lineups
      Games



Lineups
Lineups can be changed in four ways:

1) When creating or editing a Team, a default Batting Order can be defined 
for any player in the roster.    Whenever a game is created using this team, 
the game will use this Lineup information by default.    It is not necessary to 
explicitly define all or any Batting Order information in the Team Roster, 
because the entire Lineup can be modified when creating a game. 

2)  When creating a game, all team information, including the Roster and 
Lineup can be changed.    Note that team changes made here, such as the 
Starting Pitcher, apply only to this game and are not saved to the Team File.   
Permanent team changes, such as new players, should be made via the 
Team Dialog prior to creating a game.    NOTE: Ensure that the Starting 
Lineup is complete prior to starting a game.    If you begin a game with 8 
batters, ScoreBook will assume for the duration of that game that your 
team uses 8 batters!

3)  To substitute a player during a game:
      - Select Substitute Player from the Lineup Change Menu. Note: This menu 
item is only active while a game is in progress.
      - Select the Player to Remove from the Substitute Combo Box
      - Select the Substitute from the With Combo Box
      - If the Position of the Substitute is incorrect, select the appropriate 
position from the Position Combo Box
      - Select OK

4) To change player positions during a game (i.e. Players stay in game, 
but swap positions):
        - Select Change Player Positions from the Lineup Change Menu. Note: 
This menu item is only active while a game is in progress.
        - From the    Position Combo Box, select a new position for one or more 
players
        - Select OK

    See also:
      Teams & Rosters
      Games



Creating Games
After creating two Teams with complete Rosters, a new game can begin.

To create a new game:
      - Select Game from the Main Menu
      - Select New for the Edit Game Information Dialog
      - Input the game information (i.e. Date, Time, etc.)
      - Select the Home Team Select Team Button and choose one of the Team 
files (.TEM)
      - Make any necessary Home Team Roster and Starting Lineup changes by 
selecting the Edit RosterButton
    - Select the Visiting Team Select Team Button and choose a different Team 
files (.TEM)
      - Make any necessary Visiting Team Roster and Starting Lineup changes 
by selecting the Edit RosterButton
      - Select the Start Button if you wish to begin scoring.    Otherwise select 
OK to save any changes or select Cancel to abort changes to the Game file.

    See also:
      Game Play
      Teams & Rosters
      Lineups



Game Play
Games are scored by entering data into score boxes for each At Bat during a 
game.

Once play has begun, the scorer uses the Next Player and Previous Player 
Buttons to navigate between batters during an inning. 

When the batting team reaches three outs, upon confirmation, ScoreBook 
advances the game one-half inning.    It is also possible to end an inning prior
to three outs by manually pressing the Next Inning Button.

Navigating between innings can be accomplished by using the Next Inning 
and Previous Inning Buttons or by double-clicking on any existing At Bat in 
the main window.

Once an inning is complete, no At Bats can be added to or deleted from it.    
However, the information in any At Bat can be modified if needed.

ScoreBook does not consider a game complete until the Stop Game Button 
has been selected, the user chooses to Save the game, and the user then 
indicates that the game is over.    Shareware Note:    Printing Games or 
Stats is not allowed in the Shareware Version.

When a game is over, the user is prompted to select Winning, Losing, and 
Saving Pitchers from three drop down lists.    Because the rules for crediting 
pitchers with Wins, Losses, and Saves are subjective in nature, these 
decisions must be made by the scorer (See your league's rule book on the 
subject).

    See also:
      Creating Games
      Teams & Rosters
      Lineups



Scoring An At Bat
ScoreBook uses a standardized Scoring Box to capture all the events for 
every At Bat during a game.    Each scoring box is meant to show:

    - The Ball and Strike count when the runner got out or on base
    - How the batter got on base
            - How many runs were driven in by the batter
            - How and how far the runner advanced while on base
            - If the player scored or not          or
    - How the batter got out
            - The out number that inning
            - The fielders involved in getting the batter/runner out

ScoreBook uses a blown up image of the Scoring Box (see figure below) and 
the following buttons to capture this data:

        - Strike                  - Out                        - Ball
        - Advance          - Foul                      - RBI
        - On Base            - Clear Last      - Clear All

The options associated with the On Base, Out, and Advance Buttons are 
listed in the Scoring Box Section.

Many of the On Base and Out options for an At Bat will automatically update 
previous players still on base.    For example, if the bases are loaded and you 
select the On Base option Base on Balls, all three runners on base will 
automatically advance one base.    The runner on third will score (indicated 



by a gray-filled diamond), and the batter will be given an RBI.

Other options will require some minimal input.    For example, if a runner is on
second and the current batter singles, you will be prompted to indicate which
base the runner advanced to.

RBIs are automatically awarded in most conditions, however, the scorer can 
use the RBI button to manually award an RBI to a batter or remove an 
unearned RBI.    See your rule book for an explanation on when to award 
RBIs.    Clicking the RBI Button will increment the RBI counter by one.    When 
the RBI count is four, Clicking the RBI Button again will clear all RBIs.

The Clear Last Button will clear the last action initiated by the user for the At 
Bat.

The Clear All Button will clear all information about the At Bat.

Updating an At Bat once an inning is complete:
If for some reason the scorer needs to update an At Bat from a previous 
inning, care should be taken to ensure that all information about that At Bat 
has been recorded properly.    Player substitutions make it difficult for 
ScoreBook to determine what pitchers and fielders to assign.    When 
updating an At Bat that requires Fielder entries, when a potential conflict 
exists, the scorer will be prompted to select from a list of all fielders who 
have played at that position during the game.

Example:    Suppose at the end of a game, the scorer wants to change a 
single during the third inning to an error charged to the pitcher, who had 
since be removed from the game.    The scorer would:
- Select the At Bat to update by double-clicking on its Scoring Box
- Select the Clear Last Button
- Select the On Base Button, then choose the type Error
- Click the Pitchers Check Box (A list of pitchers used during the game would 
appear)
- Select the pitcher responsible for the error
- Select OK

The scorer can check or edit Batter, Runner, Pitcher, Fielder, or Error 
assignments for an At Bat.    To do this:
- Select the At Bat to update by double-clicking on its Scoring Box
- Select Modify At Bat from the File Menu
- Change assignments as desired
- Select OK

    See also:
      Scoring Legend



      Statistics Considerations



Scoring Legend
Each At Bat is tracked via a standardized Scoring Box.    The Scoring Box 
conventions are described below:

Abbreviations Used:
On Base                                                          Out                                              Advance                            
1B - Single                                    CS    - Caught Stealing                SB  - Stolen Base
2B - Double                                    LBE - Left Base Early                AB    - Awarded Base
3B - Triple                                    DNT - Did Not Tag Up                  WP    - Wild Pitch
HR - Home Run                                PO    - Picked Off                          PB    - Passed Ball
BB - Base on Balls                      F      - Fly Out                                BK    - Balk
IW - Intentional Walk                Fo    - Foul Fly Out                      E?    - Advance on Error
HP - Hit by Pitch                        DTS - Dropped 3rd Strike,        ~E    - Previous Error
AB - Awarded Base                                    Out at First                      ~WP - Previous Wild Pitch
IF - Interference                        BF    - Bunt Foul                            ~PB - Previous Passed Ball
BK - Balk                                        SF    - Sacrifice Fly                    ~BK - Previous Balk
FC - Fielder's Choice                SAC - Sacrifice Bunt
E? - Reached On Error                IF    - Interference
SAC-E? - Reached on Error        DP    - Double Play
    While Sacrificing                    TP    - Triple Play
ASE-E? - Assist with Error      K      - Strike Out Swinging
DTS-WP - Dropped 3rd                  K (Backward) - Strike Out Looking
    Strike, Wild Pitch                  LBP - Left Base Path                
DTS-PB - Dropped 3rd                  LD    - Line Drive
    Strike, Passed Ball                TBB - Touched By Own Batted Ball
                                                          MB    - Missed Base
                                                          IBB - Illegally Batted Ball
                                                          BOT - Batted Out of Turn
                                                          GO    - Ground Out
                                                          CO    - Called Out
                                                          CV  - Circle Viloation (Softball)
                                                          LOV - Leading Off Violation (Little League)
                                                          HFS - Head First Slide (Little League)

? - Denotes position of the fielder responsible for error (e.g. E3 indicates an error on the First Baseman) 

Fielder Positions:

1 - Pitcher                6 - Shortstop
2 - Catcher                7 - Left Field
3 - First Base          8 - Center Field
4 - Second Base        9 - Right Field
5 - Third Base        10 - Short Field(Softball)



Example Scoring Situations
Scoring certain events can be tricky, especially those involving more than 
one offensive player.    ScoreBook was written to handle a wide variety of 
situations.

Example 1:    Player 1 singles to left.
      - At Player 1's Scoring Box, Select the On Base Button
      - Select Single
      - When prompted to indicate where the ball was hit, click on some area in 
left field
      - Advance to the next batter's Scoring Box by selecting Next Batter

Example 2: With Player 1 on First Base, Player 2 hits into a Double Play 
(Shortstop to Second Baseman to First Baseman).
      - At Player 2's Scoring Box, Select the Out Button
      - Select Double Play
      - Click on the Fielder Check Boxes in the order the fielders touched the 
ball, in this case Short, Second, then First (Position numbers of the fielders 
involved appear in the Fielded By: Text Box)
      - Select OK
      - When prompted to "indicate other player out," select Player 1 from 1st
      - Select OK

Example 3:    With Player 1 on First Base, Player 2 grounds to the Shortstop, 
who throws to the Second Baseman covering second.    The Second Baseman 
makes no attempt to throw to first. 
      - At Player 2's Scoring Box, Select the On Base Button
      - Select Fielder's Choice
      - When prompted to indicate where Player 1 went, select the Out Button
      - Select Forced Out
      - Click on the Fielder Check Boxes in the order the fielders touched the 
ball, in this case Short, then Second
      - Select OK

Scoring Notes:

Selecting Fielders for Assists and Put Outs:    When Stats are computed, in 
most cases the last fielder in the Fielder list will be credited with a Put Out 
and all prior fielders will be credited with Assists.    Exceptions are Double and
Triple Plays which will award additional Put Outs as necessary.    When scoring
unassisted Double or Triple Plays, when prompted to input fielders, only 
select the exceptional fielder once.    The fielder will be credited with the 
correct number of Put Outs.    For more information on Put Outs and Assists, 
review the Statistics Considerations section. 



Fielders Versus Bases:    Be careful to select fielders and not just a base.    For 
example, if a player is forced out at second base, but the Shortstop catches 
the ball for the put out, don' t select the second baseman for the Put Out.

    See also:
      Scoring Legend
      Statistics Considerations



Internet Access
As of this release the Fixed It! ScoreBook Home Page URL is 
http://iquest.com/~dturner/baseball.shtml.    Unregistered users can 
download the latest shareware version of Fixed It! ScoreBook and other 
Fixed It! products such as Win A Lotto! from this site.

    See also:
      Registration



Removing ScoreBook
Since ScoreBook is self-contained (i.e., nothing is written to your Windows 
directory), removing it from your system is as easy as removing the 
ScoreBook Directory.    This can be accomplished from an MS DOS prompt by 
simply performing the deltree instruction using the ScoreBook directory as a 
parameter (e.g., DELTREE C:\BB), which will remove all ScoreBook files and 
subdirectories.    The same can be accomplished using the File Manager 
under Windows by clicking on the ScoreBook root directory and selecting 
Delete from the File Menu.

The Fixed It! Windows Group can be deleted by minimizing the group and 
selecting Delete from the Program Manager File Menu.



Sound
The Sound/No Sound options are selected via the Options Menu.    Sounds are
only available for systems with Sound Blaster compatible sound cards.    The 
default is Sound.



Printing
To Print Scorecards for a Game:
    - Select Print from the File Menu
    - Select Game
    - Choose a Game file from the Files List
    - Select the desired Scorecard(s) using the Print Option Radio Buttons
    - Select the Print Button

Note: If you get insufficient memory error messages while printing a Game, 
try printing the Home & Visitor Scorecards one at a time.    That is, change 
the Print Options Radio Button from Both to Home At Bats, then select Print.   
Then select Visitor At Bats, then select Print again.

If you still have trouble, try selecting Printer Setup and changing the 
Orientation to Landscape.

To Print a Registration Form See:
        ScoreBook Registration
 
To Print Statistics See:
        Statistics



Statistics
Some stats are kept throughout the game in the Current Pitcher and Inning 
Statistics Window.    More in-depth team and individual stats and Scatter Plots
require analysis of one or more complete games.

To view and print Player and Team Batting, Running, Fielding and Pitching 
Statistics, first select Team and Player Stats from the Statistics Menu. Then 
choose a game file (*.GAM) to be analyzed from the Files List Box.    Click on 
the Select Game Button to add this game to the Games To Analyze List Box.   
Add as many games as you like in the same manner.    Shareware Note:    
Only one game at a time may be evaluated with the Shareware version.

To remove a game from consideration, choose the game file in the Games To 
Analyze List Box, then click on the Remove Game Button.

Once all games are selected, you must choose a team from the Team To 
Analyze Drop Down List Box before you can proceed.

Once a Team is selected,    choose OK.

The Batting, Running, and Fielding Stats Window will then appear.

Use the Batter & Pitcher Radio Buttons to toggle between Batter, Runner, 
Fielder Stats and Pitcher Stats.

Select the Print Button to print all Batter, Runner, Fielder Stats and Pitcher 
Stats.    If the printout is too small to read, try changing the Printer's Page 
Orientation to Landscape.

Select the Export Button to save the displayed data to a comma-delimited 
text file, which can be imported into a word processor or spreadsheet utility.

Statistics Considerations:

ERA - The Number Of Innings Per Game Radio Buttons are provided in the 
Stats Dialog to allow correct computation of pitcher Earned Run Averages 
(ERA).    The default is 9 innings.    This can be changed to 6 or 7 based on 
the normal innings per game in your league.    The method of computing 
ERAs is described in Pitching Stats.

Errors & Fielding Average - To ensure Errors are assigned appropriately 
and Fielding Average is computed correctly, special care should be taken 
while scoring fielding errors.    

Example 1:



A runner advances two bases due to a throwing error.    Advance the player 
using the Advance Button and charge an error by selecting Error and clicking 
the check box associated with the offending player.    On the second base 
path advance, charge a Previous Error.    This will ensure that the fielder is 
charged with only one error.

Example 2:
Two runners advance a base due to a throwing error.    Advance the first 
player, charging an error as described in example one.    Advance the second 
player using Previous Error.    Again, this will ensure that the fielder is charged
with only one error.

Example 3:
The third baseman handles a ball perfectly, throws to first, but the first 
baseman drops the ball.    Because the third baseman properly handled the 
ball, he should be credited for an assist, even though the batter wasn' t put 
out.    Select the On Base Button for the batter and select Assist With Error.    
Click the check box associated with the offending player, then click all the 
fielders who touched the ball in the order they touched it, including the 
fielder who committed the error.      

Wild Pitches, Balks, & Passed Balls - Care should also be taken while 
assigning Wild Pitches, Balks, and Passed Balls.    Any time a player commits 
a mistake that allows more than one base advance, that mistake should be 
assigned once, and all other base advances should be charged as Previous 
Wild Pitch, Previous Balk, or Previous Passed Ball.    This will ensure that the 
fielders aren't overly penalized for their sins.

    See also:
      Batting, Running, Fielding Statistics
      Pitching Stats 
      Scatter Plots
      Current Pitcher/Inning Statistics



Batting, Running, & Fielding Statistics
The following is a list of the currently supported Batting, Running and 
Fielding Stats and how they are computed:
GP    - Games Played                    SAC - Sacrifice Bunts + Sacrifice Flies
IP    - Innings Played                SB    - Stolen Bases
1B    - Singles                              ATT - Stolen Base Attempts
2B    - Doubles                              PO    - Put Outs
3B    - Triples                              A      - Assists
HR    - Home Runs                          E      - Errors
BB    - Base on Balls                  SO    - Strike Outs
HBP - Times Hit By Pitch        R      - Runs Scored
RE    - Reached on Error            RBI - Runs Batted in
Batting Average                - Hits divided by Official At Bats
H (Hits)                              - Number of Singles + Doubles + Triples + Home Runs
OAB(Official At Bats)    - All complete plate appearances except when on base
                                                  as a result of Base On Balls, Intentional Walk, Hit
                                                  By Pitch, or Catcher Interference or out as a result
                                                  of a Sacrifice Fly or Sacrifice Bunt
Slugging Percentage        - Total Bases divided by Number of Official At Bats (OAB)
On Base Average                - Total Times on Base (H + BB + HBP + RE) divided by
                                                  Total At Bats (OAB + BB + HBP + RE + SAC)
Stolen Base Percentage - SB divided by ATT
Fielding Average              - (PO + A) divided by (PO + A + E)

    See also:
      Statistics 
      Pitching Statistics
      Scatter Plots
      Current Pitcher/Inning Statistics



Pitching Statistics
The following is a list of the currently supported Pitching Stats and how they 
are computed:
GS    - Games Started                    HB    - Times pitcher Hit a Batter
GC    - Games Completed                BK    - Balks
SAV - Saves                                    WP    - Wild Pitches
BF    - Batters Faced                    SO    - Strike Outs
H      - Hits allowed                      W      - Wins
1B    - Singles allowed                L      - Losses
2B    - Doubles allowed                PCT - Win/Loss percentage
3B    - Triples allowed                PO    - Put Outs
HR    - Home Runs allowed            A      - Assists
R      - Total Runs allowed          E      - Errors
BB    - Base On Balls
Fielding Average                  - (PO + A) divided by (PO + A + E)
IP (Innings Pitched)          - One third inning is given for each out.
ER (Earned Runs)                  - For ScoreBook, a run scored is always considered
                                                      "earned" unless an error, wild pitch, or passed
                                                      ball contributed to advancing a batter or runner
                                                      at least one base.
ERA (Earned Run Average) - (ER * Innings Per Game) divided by IP

    See also:
      Statistics 
      Batting, Running, Fielding Statistics
      Scatter Plots
      Current Pitcher/Inning Statistics



Current Pitcher/Inning Statistics
The following is a list of stats maintained in the Pitching and Current Inning 
Stats Window throughout the game:

Current Pitcher Stats:
    - Pitch Count
    - Strike Outs
    - Base On Balls
    - Strikes
    - Balls

Inning Stats:
    - Runs
    - Hits
    - Errors
    - Runners Left on Base

    See also:
      Statistics 
      Pitching Statistics
      Scatter Plots
      Batting, Running, Fielding Statistics



Scatter Plots
To view and print Scatter Plots:
    - Select Scatter Plots from the Statistics Menu
    - Choose a game file (*.GAM) to be analyzed from the Files List Box.
    - Click on the Select Game Button to add this game to the Games To 
Analyze List Box.    Add as many games as you like in the same manner.
    - Select OK
    - Select a batter and a pitcher from the drop down lists.    Choose ALL 
PITCHERS to see how a particular batter performs against all pitchers.    
Choose ALL BATTERS to see how a particular pitcher fares against all batters.
    - Three plots appear, a Hit plot, an Out plot, and a Combined Hit and Out 
Plot.    Red marks indicate hits, blue marks, outs.
    - Select the Print button to print the three plots.
      
    See also:
      Statistics 
      Pitching Statistics
      Batting, Running, Fielding Statistics



Rob                    &                    Don

. . . remember your friends at Fixed It! Software



ScoreBook Registration
To receive a Registered copy of Fixed It! ScoreBook:

      - Select Print from the File Menu.
      - Select Registration Form...
      - Enter your name, mailing address, e-mail address and comments into 
the menu fields.    If you provide an e-mail address, we will status your order 
as soon as we receive it.    Also, please provide feedback in the Comments 
field, especially features you would like to see implemented in future 
releases of ScoreBook.
      - Select the OK button.
      - Make out a check or money order to Fixed It! Software for $50 
(U.S. Funds only!).
      - Mail your form and check to:

                  Fixed It! Software
                  P.O. Box 372
                  Capshaw, AL 35742

To place a Credit Card Order, access the Fixed It! ScoreBook Home Page 
(http://iquest.com/~dturner/baseball.shtml) for the latest phone number and 
instructions. 

Registering has the following benefits:

      - Full-featured product with no nagware or other shareware limitations 
(such as printing games and stats)
      - Six months of free technical support (via e-mail), support files, and minor
upgrades (via the registered portion of the Fixed It! ScoreBook Home 
Page)




